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Warranty and liability

Note The Application Examples are not binding and do not claim to be complete
regarding the circuits shown, equipping and any eventuality. The Application
Examples do not represent customer-specific solutions. They are only intended
to provide support for typical applications. You are responsible for ensuring that
the described products are used correctly. These application examples do not
relieve you of the responsibility to use safe practices in application, installation,
operation and maintenance. When using these Application Examples, you
recognize that we cannot be made liable for any damage/claims beyond the
liability clause described. We reserve the right to make changes to these
Application Examples at any time without prior notice.
If there are any deviations between the recommendations provided in these
application examples and other Siemens publications – e.g. Catalogs – the
contents of the other documents have priority.

We do not accept any liability for the information contained in this document.

Any claims against us – based on whatever legal reason – resulting from the use of
the examples, information, programs, engineering and performance data etc.,
described in this Application Example shall be excluded. Such an exclusion shall
not apply in the case of mandatory liability, e.g. under the German Product Liability
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life,
body or health, guarantee for the quality of a product, fraudulent concealment of a
deficiency or breach of a condition which goes to the root of the contract
(“wesentliche Vertragspflichten”). The damages for a breach of a substantial
contractual obligation are, however, limited to the foreseeable damage, typical for
the type of contract, except in the event of intent or gross negligence or injury to
life, body or health. The above provisions do not imply a change of the burden of
proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts
hereof is prohibited without the expressed consent of the Siemens AG.

Security
informa-
tion

Siemens provides products and solutions with industrial security functions that
support the secure operation of plants, solutions, machines, equipment and/or
networks. They are important components in a holistic industrial security
concept. With this in mind, Siemens’ products and solutions undergo continuous
development. Siemens recommends strongly that you regularly check for
product updates.

For the secure operation of Siemens products and solutions, it is necessary to
take suitable preventive action (e.g. cell protection concept) and integrate each
component into a holistic, state-of-the-art industrial security concept.  Third-party
products that may be in use should also be considered.  For more information
about industrial security, visit http://www.siemens.com/industrialsecurity.

To stay informed about product updates as they occur, sign up for a product-
specific newsletter. For more information, visit
http://support.industry.siemens.com.

http://www.siemens.com/industrialsecurity
http://support.industry.siemens.com/
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Preface
Purpose of this documentation

Based on PCS 7 applications, this document describes:
 Redundant I/O modules, especially with channel-granular functionality
 Installation, wiring and configuration of redundant ET 200M stations
 The use of MTA terminal modules (Marshalled Termination Assemblies) as

an interface between the distributed I/O modules and the actuators or sensors
 Diagnostic options on a fault-tolerant system with redundant peripherals in

case of error

Basic knowledge required
This documentation is intended for persons involved in configuration,
commissioning and servicing of automation systems and who have basic
knowledge of SIMATIC PCS 7.

Validity
Valid from SIMATIC PCS 7 V8.1.
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Position in the information landscape
You can find further information regarding the subject of redundancy in PCS 7 and
for dealing directly with the different high-availability components in the following
documents.

Document Content

SIMATIC Process Control System PCS 7
Released modules

 Approved SIMATIC modules for PCS 7 V8.1

SIMATIC Process Control System PCS 7
Fault-tolerant Process Control Systems

 Solutions for the peripherals
 Designing high-availability components

SIMATIC Fault-tolerant systems S7-400H  Installing a CPU 41x-H
 Connecting redundant I/O

SIMATIC Distributed I/O device ET 200M  Installing the ET 200M
SIMATIC S7-300 S7-300 Module data  Technical specifications about the signal modules
ET 200M Marshalled Termination Assemblies
Remote I/O Modules

 Commissioning the MTA boards

SIMATIC PCS 7 Process Control System
Advanced Process Library

 Description of the PCS 7 channel blocks

PCS 7 in Practice - Plant Asset Management  Passivation/depassivation of redundant modules

SIMATIC ET 200M distributed I/O device
HART analog modules

 Connecting actuators/sensors in
redundant mode

NOTE You can find the sources listed in the table in the Industry Online Support Portal
(https://support.industry.siemens.com).

https://support.industry.siemens.com/
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1 Introduction
1.1 Redundant I/O

The high-availability in PCS 7 is basically applicable to all levels. In this
documentation, the focus lies on the application of redundant distributed I/O using
ET 200M modules. It explains with particular emphasis the wiring options of the
input/output modules as well as the individual configuration steps.
The term I refers to input/output (I/O) modules, which are duplicated and
configured/operated redundantly in pairs. If a module fails, a CPU or process signal
can be processed by the operational module. The entire signal path to the
sensor/actuator is redundant.
As interface modules, the MTA terminal modules (Marshalled Termination
Assemblies) offer the possibility of connecting field devices, sensors and actuators
in a simple, quick and safe manner to the input/output modules of the ET 200M.
The document shows how such MTA are structured, what important features and
advantages they possess, and how the implementation can be carried out without
complicated wiring and configuration.

Note The manual "SIMATIC Fault-tolerant systems S7-400H" provides extensive
information about the redundancy mechanisms in the AS level.

1.2 Behavior in case of channel interference

The passivation behavior determines how redundant input/output modules behave
after a channel fault (e.g. wire break, short-circuit on the signal line). The response
to a channel fault is dependent on the following aspects:
 Modules used
 Configuration
 Version of the PCS 7 library

– As from PCS 7 V7.1, the possible passivation behavior is automatically
detected based on the configured modules. The channel-granular
passivation behavior is adjusted.

– The library RedLib V3.x only allows the module-granular passivation
behavior to be selected.

– The library RedLib (from V4) enables the channel-granular passivation
behavior to be adjusted.

Channel faults, whether due to discrepancy or due to a diagnostic interrupt (OB82),
lead to the passivation of the respective channel. If the fault is cleared, the so-
called 'depassivation' activates the channel or the modules passivated due to
module faults. Channel-granular passivation significantly increases the availability
in the following cases:
 Relatively frequent encoder failures
 Repairs that take a long time
 Multiple channel errors on one module
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When switching from the "module-granular passivation behavior" (RedLib V3.x) to
"channel-granular passivation behavior" (from RedLib V4.x), you must consider the
following points:
 When upgrading from PCS 7 V7.1 SP4 to PCS 7 V8.1 (with utilization of new

functions) new compatible blocks are imported into the project from the library
"Redundant IO CGP V52" if using redundant peripherals.

 When converting a project, make sure that all blocks with the names
FB450-453 and FC450-451 have been deleted from the block folder.
Perform this step in every relevant program. Compile and load your project.

1.3 Hardware components

Basically, an increase in availability can happen in two ways. On the one hand, via
a single-channel switched I/O and on the other, via a redundant peripheral such as
the example shown Figure 1-1. The designs in this document are mainly restricted
to the use of redundant peripherals with two ET 200M stations.
Figure 1-1

A redundant peripheral exists when the input/output modules are duplicated for
a process signal and can be addressed by the AS (S7-400H).
In PCS 7, a redundant peripheral can be built with selected S7-300 I/O modules
of the ET 200M series.
The distributed I/O ET 200M is connected as a DP slave to a high-availability
automation system (DP master) via PROFIBUS DP. A redundant structure is
achieved by an additional ET 200M and an additional PROFIBUS DP connection.
In the following sections, the individual hardware components required to build
a high-availability system with redundant distributed I/O are described in detail.
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1.3.1 High-availability automation system (AS)

Fault-tolerant automation systems are used to minimize the risk of production
failures.
For the S7-400H to remain always available, it is built as a redundant system.
This means that all essential components are duplicated, i.e. the central processing
unit CPU, power supply and hardware for coupling the two CPUs.
Table 1-1: CPU types that can be used starting from PCS 7 V8.1

Name MLFB FW

CPU 410-5H process automation 6ES7 410-5HX08-0AB0 V8.1.x
CPU 412-5H PN/DP 6ES7 412-5HK06-0AB0 V6.x

CPU 414-5H PN/DP 6ES7 414-5HM06-0AB0 V6.x

CPU 416-5H PN/DP 6ES7 416-5HS06-0AB0 V6.x

CPU 417-5H PN/DP 6ES7 417-5HT06-0AB0 V6.x
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1.3.2 Interface modules (IM)

Interface modules (IM) are used by the distributed I/O device ET 200M as
a PROFIBUS DP interface. With redundant peripherals, one must ensure that
two interface modules (IMs) are used per ET 200M station and that the same bus
address is set for both modules (via dip switches).
This ensures that if the active interface module fails during operation, the passive
interface module takes over the corresponding function smoothly. The active
interface is indicated by the lit ACT LED on the respective interface module.
Table 1–2: IM module for redundant applications

Name MLFB Product Brief

ET 200M - IM 153-2 6ES7 153-2BA02-0XB0
V5.x

Bus interface for S7-300 SMs, FMs
(without FM 356-4),
module exchange during operation,
expansion of the instrumentation and
control functions, up to 12 I/O modules
can be operated

ET 200M - IM 153-2 6ES7 153-2BA82-0XB0
V5.x

Bus interface for S7-300 SMs
(outdoor),
FMs (without FM 356-4),
module exchange during operation,
expansion of the instrumentation and
control functions, up to 12 I/O modules
can be operated

ET 200M - IM 153-2 6ES7 153-2BA70-0XB0 Bus interface for S7-300 SMs
(outdoor); FMs (without FM 356-4),
module exchange during operation, up
to 12 I/O modules can be operated
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1.3.3 Bus modules

As mentioned above, in PCS 7 only active bus modules can be used for redundant
applications with ET 200M. This enables removal and insertion of modules during
operation. To achieve redundant operation, each ET 200M requires two interface
modules IM 153-2 high feature to be mounted on the active bus module.
For the ET 200M standard modules (e.g. DI, DO, AI, AO), further bus modules are
used.
Figure 1–2: Possible configuration of an ET 200M station. It should be noted that the use of

the redundant power supply module (PS) is optiona

Note For more information about the permitted combination of interfaces and bus
modules, as well as available functionalities, please refer to the manual "
SIMATIC Distributed I/O device ET 200M ".

In practice, an IM 153 redundancy bundle is often ordered for the installation of
a redundant ET 200M station. This consists of two IM 153-2 high feature and one
active bus module IM 153/IM 153.

PSPS

PS
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1.3.4 Input/output module (I/O)

I/O modules with channel-granular functionality
From PCS 7 V7.0 upwards, you can specify how redundant input/output modules
behave in case of a channel fault (e.g. wire break, short circuit on the signal line).
For a channel fault, one can expect the following reactions depending on the
module used and the configuration:
 If a fault occurs, only the faulty channel is passivated (recommended channel-

granular passivation)

 The entire module is passivated when a fault occurs (module-granular
passivation)

The following Table 1–3 shows input and output modules, which are suitable for
the redundant configuration with ET 200M and equipped with channel-granular
functionality. It should be noted that modules with channel-granular properties can
be also always used for module-granular functionality but not the other way round.
Table 1–3

Name MLFB

Digital input module SM321

DI 16x24 V DC, interrupt 6ES7 321-7BH01-0AB0
DI 16xDC24V, Alarm; high feature 6ES7 321-7BH01-0AB0 ES 6 (revision)
DI 4xNAMUR,Ex 6ES7 321-7RD00-0AB0
DI 16xNAMUR 6ES7 321-7TH00-0AB0

Digital output module SM322
DO 8xDC24V/2A 6ES7 322-1BF01-0AA0
DO 4xDC24V/10mA, Ex 6ES7 322-5SD00-0AB0

Analog input modules SM331
AI 8x16Bit 6ES7 331-7NF00-0AB0
AI 8x16Bit 6ES7 331-7NF10-0AB0
AI 6xTC 6ES7 331-7PE10-0AB0
AI 4x0/4...20mA, Ex 6ES7 331-7RD00-0AB0
AI 8x0/4…20mA HART 6ES7 331-7TF01-0AB0

Analog output modules SM332
AO 4x12Bit 6ES7 332-5HD01-0AB0
AO 8x12Bit 6ES7 332-5HF00-0AB0
AO 4x0/4...20mA,Ex 6ES7 332-5RD00-0AB0
AO 8x0/4…20mA HART 6ES7 332-8TF01-0AB0

Note When using HART modules, you have to use PCS 7 from V7.0 SP1. Specific
interface modules (6ES7 153-2BA02-0XB0 or 6ES7 153-2BA82-0XB0) must
also be used.
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Special features of HART modules

Note When using redundant HART analog input modules, only one transmitter
(encoder) can be connected.

Redundant HART signal modules work as "Primary Master" and "Secondary
Master" to allow simultaneous HART communication via both modules with a field
device.
The system declares the module with the lower address as the "Primary Master".
If this one fails, communication happens via the
"Secondary Master".

Note In order not to affect this system behavior, no other HART Master, e.g. handheld,
may be connected.

1.3.5 MTA (Marshalled Termination Assemblies) terminal module

The MTA terminal modules offer the possibility of connecting field devices, sensors
and actuators easily and quickly to the I/O modules of the distributed I/O ET 200M.
The MTA are each tailored to specific I/O modules from the ET 200M range. MTA
versions for standard I/O modules are also available for redundant and safety-
related I/O modules.
They can be used to significantly reduce the costs and required work for cabling
and commissioning, and prevent wiring errors.
The following figure illustrates the capabilities of MTA together with ET 200M
stations (with an encoder).
Figure 1–3

The MTA terminal modules are connected to the I/O modules of the ET 200M via
3m or 8m long pre-assembled cables.
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Product features
MTA are characterized by the following properties:
 Redundant 24 V DC power supply with LED display
 Screw-type terminals for direct (1:1) connection of field devices, sensors and

actuators
 Fuse with LED indicator for each I/O channel
 Pre-assembled cables to connect the MTA with the I/O module
 with SUB D connector, 50/25-pin, plug socket version, for MTA
 with Siemens front connector, 40/20-pin, plug socket version, for the ET 200M

module
 On-board simulation capabilities for IBS purposes (wire break, to switch

ON/OFF a channel)
 Tested as a SIMATIC PCS 7 system component and approved with

appropriate approvals (FM, UL, CE, ATEX, TÜV (German Technical
Inspectorate))

Advantages
 MTA allow quick and simple wiring to field devices
 Direct connection of field devices
 SUB D connector to connect pre-assembled cables
 A backup for each channel with LED display
 Redundant 24 V DC power supply
 On-board simulation capabilities, e.g. for commissioning purposes
 Support for redundant ET 200M modules
 Channel-granular protection
 Cables must be accessible
 Internal potential distribution
 Easy maintenance with plug connections
 Faster commissioning
 Connection possibility for HART modem to the MTA

Note For more detailed information, refer to the "ET 200M Marshalled Termination
Assemblies Remote I/O Modules".
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In the case of the MTA, please note that an MTA module can only be connected
with certain input/output modules. Table 1–4 shows possible connection
possibilities.
Table 1–4

Product label MLFB
8 channels, AI 6ES7650-1AA52-2XX0
8 channels, AO 6ES7650-1AB51-2XX0

8 channels, AI HART 6ES7650-1AA61-2XX0
8 channels, AO HART 6ES7650-1AB61-2XX0

8 channels, AI TC 6ES7650-1AF51-2XX0
8 channels, AI RTD 6ES7650-1AG51-2XX0

16 channels, DO 6ES7650-1AD11-2XX0
6 channels F-AI HART

(safety-related)
6ES7650-1AH62-5XX0

16 channels, DI 6ES7650-1AC11-3XX0
24 channels F-DI
(safety-related)

6ES7650-1AK11-7XX0

10 channels F-DO
(safety-related)

6ES7650-1AL11-6XX0

16 channels DO relay 6ES7650-1AM30-3XX0
10 channels F-DO

Relay (safety-related)
6ES7650-1AM31-6XX0

Note For detailed information about each MTA type, please refer to the product
release: https://support.industry.siemens.com/cs/ww/en/view/29289048

https://support.industry.siemens.com/cs/ww/en/view/29289048
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2 Configuring and wiring
2.1 Redundant PROFIBUS DP connection

The transition from the automation system to PROFIBUS DP is done via
a CP 443-5 Extended or via one of the two internal PROFIBUS DP interfaces
of the CPU.

2.2 Connecting an MTA terminal module

MTA provide quick and easy connection of the field level to the ET 200M
I/O modules. They reduce the amount of wiring effort and avoid mistakes.
Figure 2-1

Note To achieve maximum availability with redundant encoders, two MTA are also
required, each being connected between the input modules and the encoders.
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The connection of the ET 200M modules to the MTA is established via the
connecting cable of the correct type, as also shown in the following figure with
an MTA AI as an example.
Figure 2–2

Preassembled cable with SUB-D
connector for connection to SIEMENS
PCS 7 MTA

Screwing terminals
for direct connection
to field devices

2 connections for
redundant construction

Preassembled cable with SUB-D
connector for connection to SIEMENS
PCS 7 MTA

Screwing terminals
for direct connection
to field devices

2 connections for
redundant construction
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Connection example of sensors to the screw-type terminals on the MTA
The following figure shows the encoder connection using the example of digital
inputs.
Figure 2–3

Note For more detailed information, refer to the "ET 200M Marshalled Termination
Assemblies Remote I/O Modules".

Anschluss Kanal 1

Anschluss Kanal 13

Connection channel 1

Connection channel 13

Anschluss Kanal 1

Anschluss Kanal 13

Connection channel 1

Connection channel 13
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2.3 Redundant connections of the distributed I/O

Figure 2–4 shows an example of the redundant peripherals connection, switched
in the DP slave mode. In contrast to the redundant peripherals in the one-sided DP
slave mode, the signal modules in the ET 200M distributed I/O devices are hereby
used in pairs.
Figure 2–4

The following chapters describe how to connect the sensor to the signal modules.

Note For detailed diagrams and assembly data, refer to the manual "SIMATIC S7-300
S7-300 Module data".

Specific notes for the redundant use of certain signal modules, can be found in
the manual "SIMATIC Fault-tolerant systems S7-400H" or in the manual
"SIMATIC PCS 7 process control system CPU 410-5H Process Automation"

Redundant module pair
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2.3.1 Digital input

Sensor connection
One or two sensors are connected to two redundant SM 321; DI 16 x DC 24 V
(1 of 2 structure).
Figure 2-5

To achieve maximum availability, it is recommended to use two encoders.

Note When connecting an encoder to several digital input modules, the redundant
modules must operate at the same reference potential.

With one encoder With two encoders
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Connection and schematic circuit diagram of the SM 321; DI 16 x DC 24 V
The following picture shows the schematic circuit diagram of the digital input
module with channel-granular functionality (6ES7 321-7BH01-0AB0).
Figure 2–6

Table 2–1

Digit Description

1 Channel number
2 Status displays – green

Fault display – red
Encoder supply VS – green

3 Backplane bus interface
4 Open-circuit detection
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Example
An encoder is connected to channel 0 of each of the two SM 321; DI 16 x DC 24 V:
Figure 2–2
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2.3.2 Digital output

Controlling the final element control
The actuator is connected to two redundant SM322; DO 16 x DC 24 V / 0.5 A
(1 of 2 structure). Depending on the type of digital output modules, additional
diodes must be used in redundant mode.

Note You can find the overview about which digital output modules you have to
interconnect via external diodes in table 8-4 of the manual "S7-400H Automation
System, High-availability Systems".

Figure 2–7

The digital output module with channel-granular functionality
(6ES7 322-8BH01-0AB0) is interconnected without external diodes.

Note The digital output modules must be connected to a common load voltage supply.

With external diodes Diodes integrated into the module

Actuator
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Connection and schematic circuit diagram of the SM 322; DO 16 x DC 24 V / 0.5 A
The following picture shows the schematic circuit diagram of the digital output
module with channel-granular functionality (6ES7 322-8BH01-0AB0).
Figure 2–5

Table 2–2

Digit Description

1 Status displays (green)
Fault display (red)

2 Channel number
The numbers 0 to 7 on the right side are the channel numbers 8 to 15

3 Channel status (green)
4 Channel fault (red)
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Example
An actuator is connected via channel 8 to each of the two SM 322;
DO 16xDC 24V/0.5A:
Figure 2–8
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2.3.3 Analog input

Encoder connection
The analog input module SM331; AI 8x16 bit can be used with one or two
encoders in redundant operation (1 of 2 structure).
Figure 2–9

To achieve maximum availability, it is recommended to use redundant encoders.

Note When using redundant HART analog input modules, only one transmitter
(encoder) can be connected.

With voltage encoder With current encoder (direct)

With current encoder (indirect)

With two encoders
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Connection and schematic circuit diagram of the SM 331; AI 8 x 16 bit (voltage
measurement)

The following two pictures each show the schematic circuit diagram of the analog
input module SM331 AI 8x16 bit (6ES7 331-7NF00-0AB0) with channel-granular
functionality for voltage and current measurement.
Figure 2–10

Table 2–3

Digit Description

1 Voltage measurement
2 Backplane bus interface
3 Electrical isolation
4 Analog-to-Digital Converter (ADC)
5 Equipotential bonding
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Connection and schematic circuit diagram of the SM 331; AI 8 x 16 bit (current
measurement)

For current measurements, the voltage terminals are closed in parallel with the
corresponding current sensing resistor. Bridge the channel input terminals with
the adjacent connector terminals.
For example, to configure channel 0 for the current measurement, you have to
bridge the terminals 22 and 2 and the terminals 23 and 3.
At the channel configured for current measurements, connect the current sensing
resistor to the adjacent channel terminals in order to achieve the specified
precision.
4-wire transducer (channel 0) or
2-wire transducer with external power supply (channel 7)
Figure 2–11
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Table 2–4

Digit Description

1 Backplane bus interface
2 Electrical isolation
3 Analog-to-Digital Converter (ADC)
4 CH 0 for 4-wire transducer
5 CH 7 for 2-wire transducer (with external supply)
6 Equipotential bonding

Connection and schematic circuit diagram of the SM 331; AI 8 x 0/4…20 mA HART
The following picture shows the schematic circuit diagram of the analog HART
input module SM331 AI 8x0/4...20 mA (6ES7 331-7TF01-0AB0) with channel-
granular functionality.

Figure 2–12
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Example of an SM 331; AI 8 x 16 bit
The following figure shows the connection of a transmitter to two AI 8 x 16 bit
modules for the voltage measurement.
Figure 2–13
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Example of an SM 331; AI 8x0/4…20 mA HART (2-wire transducer)

Note A 2-wire transducer must be connected and configured to two redundant HART
analog input modules as a 4-wire transducer.

You can find more detailed information in the manual "Distributed I/O Device
ET 200M HART Analog Modules".

The terminals 10 and 11 may not be connected to the front connector
(see Figure 2–12).
Figure 2–14

The interconnected Zener diodes are required if the system is to continue
functioning while dragging a module.
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Example of an SM 331; AI 8x0/4…20 mA HART (4-wire transducer)
A 4-wire transducer is connected to two redundant HART analog input modules:
Figure 2–15

The interconnected Zener diodes are required if the system is to continue
functioning while dragging a module.
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2.3.4 Analog output

Controlling the final element control
For the high-availability control of a final controlling element, two outputs of two
SM 332; AO 8x12 bit are switched in parallel via diodes (1 of 2 structure).
Only analog output modules with current outputs can be operated redundantly
(0 to 20 mA or 4 to 20 mA).
Figure 2–16

Each of both outputs transmits half the value. If one of the modules fails, the other
output transmits the full value.

Final
controlling
element
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Connection and schematic circuit diagram of the SM 332; AO 8 x 12 bit (voltage output)
The following picture shows the schematic circuit diagram of the analog output
module SM332 AO 8x12 bit (6ES7 332-5HF00-0AB0) with channel-granular
functionality in the 2 and 4-wire connection for voltage output.
 2-wire connection without compensation of line resistance

 4-wire connection with compensation of line resistance
Figure 2–17

Table 2–5

Digit Description

1 DAC
2 Internal supply
3 Equipotential bonding
4 Functional grounding
5 Backplane bus interface
6 Electrical isolation
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Connection and schematic circuit diagram of the SM 332; AO 8 x 12 bit (current output)
The following picture shows the schematic circuit diagram of the analog output
module SM332 AO 8x12 bit (6ES7 332-5HF00-0AB0) with channel-granular
functionality as current output.
Figure 2–18

Table 2–6

Digit Description

1 DAC
2 Internal supply
3 Equipotential bonding
4 Functional grounding
5 Backplane bus interface
6 Electrical isolation
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Connection and schematic circuit diagram of the SM 332; AO 8 x 16Bit, 0/4…20mA HART
The following picture shows the schematic circuit diagram of the analog HART
output module SM332 AO 8x16 bit, 0/4…20mA (6ES7 332-8TF01-0AB0) with
channel-granular functionality.

Figure 2–19
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Example of an SM 332; AO 8 x 12 bit
The actuator is connected to channel 0 of each of the two redundant SM 332;
AO 8 x 12 bit.

Figure 2–20

Note Suitable diodes include, for example, types from the series 1N4003 ... 1N4007 or
any other diode with U_r> = 200 V and I_F> = 1 A.

It makes sense to separate module weight and load weight. There must be
equipotential bonding between both.
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Example of an SM 332; AO 8 x 16Bit, 0/4…20mA HART
The actuator is connected to two redundant HART analog output modules.
Figure 2–21
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3 Configuring the redundant peripherals
The following sections describe the configuration of individual components of the
distributed IO with PCS 7. It is assumed that a PCS 7 project has been already
created with an H station using the Project Wizard.
The following configuration steps are described:
 CPU settings (H parameters)

 Configuring the first ET 200M (IM 153-2 interface module)

 Configuring the individual signal modules IOs

 Configuring the second ET 200M via copying

 Redundancy settings at the signal modules

 Symbolic name assignment

 CFC configuration

3.1 CPU settings

To enable redundant operation between the AS and the distributed I/O, the CPU
requires a certain configuration.

Requirements
 The PCS 7 project with a SIMATIC H station is opened in SIMATIC Manager.

 If channel-granular passivation behavior is required, corresponding signal
modules must be used when configuring the ET 200M (see ch. 1.3).
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Procedure
Table 3–1

Activity Screenshot

1. Open the SIMATIC H station in the HW
Configure.

2. Select the first used CPU in slot 3 of the
rack (0) and select the menu command
"Edit > Object Properties".

3. Switch to the “Cyclic Interrupts” tab.
Use the drop down list to select the desired
process picture for those OB cyclic
interrupts, where the channel blocks
are to be installed at a later stage.



3 Configuring the redundant peripherals
3.1 CPU settings

Configuration of Redundant I/O Modules
Entry-ID: 28430682,    V2.0,    03/2015 40

S
ie

m
en

s
A

G
20

15
A

ll
rig

ht
s

re
se

rv
ed

Activity Screenshot

4. Switch to the "H Parameters" tab.
Take note of those data blocks in the field
"Data block no.", which are defined as a
standard encoder, so that you don't use
them elsewhere in your configuration.
In the drop-down list "Passivation
behavior", select the desired setting
(channel-granular or module-granular).
Click the button "Calculate…" in the field
"Update the Standby CPU".
These settings are performed to calculate
the monitoring times.

Note:
This defines how the redundant input/output
modules behave in case of channel faults
(see chapter 1.4). This setting is intended
for all redundantly configured signal
modules that are connected to the CPU.

5. Switch to the "Cycle/Clock Memory" tab.
Under "OB 85 - call up at I/O access error",
select "Only for incoming and outgoing
errors" from the drop-down list.
Click "OK" to close the properties dialog.

Note For more information about the settings on the CPU, refer to the manual
"SIMATIC Process Control System PCS 7 Fault-tolerant Process Control
Systems".
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3.2 Configuring the ET 200M (IM 153-2 interface module)

Requirements
 The PCS 7 project with a SIMATIC H station is opened in SIMATIC Manager.

 In HW Config, a redundant PROFIBUS-DP master system is configured for the
SIMATIC H station.

 The HW Config of the SIMATIC H station is open. If the hardware catalog is
not visible, select the menu command "View > Catalog".

Procedure
Table 3–2

Activity Screenshot

6. In the "Profile" field of the hardware catalog,
select the current PCS 7 profile from the
drop-down menu.
Double-click on the catalog "PROFIBUS
DP". In the catalog, go to "PROFIBUS DP>
ET 200M", select the suitable redundancy
capable interface module IM 153-2 and
drag-and-drop it onto one of the two
PROFIBUS DP streams.
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Activity Screenshot

7. Enter the address in the dialog box
"PROFIBUS IM 153-2 Interface Properties"
and click "OK".
The connection to the redundant
PROFIBUS DP stream is automatically
established.

3.3 Configuring the signal modules

The following section explains the procedure for configuring the standard and
HART signal modules.

Note For the time being do not add any HART field devices to the HART signal
modules. This sequence will be explained in chapter 3.7.

Requirements
 The PCS 7 project with an H CPU has been created and is open in SIMATIC

Manager.

 A redundant PROFIBUS-DP master system is configured for the SIMATIC
H station in HW ConFigure

 In HW Config, the interface module IM 153-2 is configured for the ET 200M
at the redundant PROFIBUS DP.
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Procedure
Table 3–3

Activity Screenshot

1. Select the configured IM 153-2. The module
overview is shown in the lower pane.
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2. In the hardware catalog, under "PROFIBUS
DP > ET 200M", select the same interface
module, which you have already dragged to
the PROFIBUS DP master system via drag-
and-drop.

3. Select a redundancy capable signal module
in the subdirectories and drag-and-drop it
into a free slot of the IM 153-2 (module
overview).
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4. Repeat steps 1-3 for further signal modules.
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3.4 Configuring the second ET 200M

Once you have configured the first ET 200M with all the necessary components
(IM 153-2 interface module, signal modules), you must now configure the second
redundant ET 200M. It should be noted that redundant operation is only possible
with modules that have the same MLFB. To avoid configuration errors, it is
therefore advisable to copy the first ET 200M and paste it in the same master
system.

Requirements
 The PCS 7 project with an H CPU has been created and is open in SIMATIC

Manager.

 A redundant PROFIBUS-DP master system is configured for the SIMATIC
H station in HW ConFigure

 In HW Config, the interface module IM 153-2 is configured for the ET 200M
at the redundant PROFIBUS DP.

 All required signal modules are configured.

Procedure
Table 3–4

Activity Screenshot

1. Open HW KonFigure Select the already
configured ET 200M and copy it to the
clipboard.
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Activity Screenshot

2. Select one of the PROFIBUS DP streams
and paste the copied ET 200M.

3. Allocate the address of the redundant slave
in the appearing properties dialog
"PROFIBUS Interface IM 153-2" and
click "OK". Make sure that this address
is different from the address of the first
ET 200M.
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3.5 Signal module settings

Once you have configured both ET 200M stations, you have to change various
settings in your standard and HART signal modules.
Redundant modules must be in the process image of the inputs or outputs.
Redundant modules are always accessed using the process image.

Requirements
 The PCS 7 project with an H CPU has been created and is open in SIMATIC

Manager.

 A redundant PROFIBUS-DP master system is configured for the SIMATIC
H station in HW ConFigure

 In HW Config, the interface module IM 153-2 is configured for the ET 200M
at the redundant PROFIBUS DP.

 All required signal modules are configured.

 The redundant ET 200M has been configured.

Procedure
Table 3–5

Activity Screenshot

1. Open HW KonFigure
Select once again the first
IM 153-2.
Double-click a signal module in the module
overview. The dialog box "Properties" of
this module is opened.

2. Switch to the “Addresses” tab.
Select the desired process image partition
from the drop-down list "Process image".
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Activity Screenshot

3. Then select the "Redundancy" tab.
In the "Redundancy" drop-down list,
select the entry "2 modules".

4. Click on the "Find" button. The dialog
window "Find Redundant Module" opens.

5. In the "Subsystem" list, select the DP
master system in which the redundant
signal module is configured.
All PROFIBUS addresses, available on this
DP master system, are displayed in the
field "PROFIBUS Address".

6. In the field "PROFIBUS Address", select
the IM 153-2 in which the redundant signal
module is configured. The redundant
module field: shows the redundancy
capable signal modules available in this
IM 153-2, for which no redundancy has
yet been configured.
In the Redundant module field, select
the signal module which is to be used as
a redundant signal module and click the
"OK" button.
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Activity Screenshot

7. The redundant signal modules are now
listed in the "Module Overview" field.
You can also set additional parameters
(see chapter 3.6 Additional parameter
settings for the configuration of the
redundant AI modules").
These additional parameters can only be
set for the input modules DI and AI. Click
the "OK" button to apply the settings.

By clicking the "Help" button you can get
further information about each parameter.

8. Repeat steps 1 to 7 for all the signal
modules you wish to connect redundantly.
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3.6 Additional parameter settings for the configuration of
the redundant AI modules

This chapter is intended to assist you in configuring the various parameters that
must be set for redundant AI modules.
To do so, you have to take two main points into account:
 Special redundancy-related parameters in the HW Config
 Time or cycle considerations

Figure 3–1

By clicking the "Help" button you can get further information about the following
parameters:
 Tolerance window

A percentage of the full-scale value of the measuring range is configured.
Two analog values are equal if they are within the tolerance window.

 Time discrepancy
It is the maximum allowable time in which the redundant input signals can be
different.

 Value applied
The "Value applied" is the value of the two analog input values (higher value /
lower value), which is transferred to the user program.
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Discrepancy time / deviation time
As described in the help for AI modules, the deviation time of AI modules should
be a multiple of the update time. To calculate the update time, the following
parameters must be considered:
 Update time of the AI modules
 Cycle time of the PROFIBUS (can be ignored if the baud rate is  1.5 Mpps).
 Update time of the (partial) process images (TPA)

The update time of an analog value for an analog input card, such as 6ES 7331-
7TF01, can be taken from the table 3–6.
First, select the parameter "Integration time / interference frequency suppression".
Then you allocate the number of channels used.

Table 3–6: Analog value for parameters

Analog value conversion

Principle of
measurement

SIGMA DELTA

Integration time /
interference frequency
suppression (per channel)

60 Hz 50 Hz 10 Hz

Integration time error ± 0.05% ± 0.04% ± 0.02%
Integration time in ms 16.6 20 100
Basic reaction time
including integration time in
ms (per channel)

55 65 305

Basic module execution
time in ms (all channels
enabled)

440 520 2440

Smoothing the measured
value

Step:
None
Weak
Average
Strong

Time constant:
1 x cycle time ***
4 x cycle time ***
32 x cycle time ***
64 x cycle time ***

Max module cycle:
2.44 s
9.76 s
78.08 s
156.16 s

Table 3–7: Examples

Integration time / interference frequency
suppression

Number of channels
used

Update time
of module

50 Hz 1 65 ms
50 Hz 4 260 ms
50 Hz 8 520 ms
10 Hz 1 305 ms
10 Hz 4 1220 ms
10 Hz 8 2440 ms
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To obtain the update time of the (partial) process image (TPA), in the first step,
the assigned (partial) process image of the AI module in question must be found,
as shown in this picture.
Figure 3–2

In the second step, the cycle time is determined in the properties of the CPU.
In this example, the update time of the (partial) process image (TPA) is 500ms
for the used TPA 3
Figure 3–3

Calculation of total deviation time:

Time deviation = 2 * (time module + time TPA)
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The factor 2 is the smallest factor that may be used. If the process conditions allow
a higher value, the factor can also be 3 or 4.

Table 3–8. Examples

Parameter Discrepancy time to be set

50 Hz, 1 channel, TPA = 500 ms 1130 ms
50 Hz, 4 channels, TPA = 500 ms 1520 ms
50 Hz, 8 channels, TPA = 500 ms 2040 ms
10 Hz, 8 channels, TPA = 50 ms 5880 ms

Note In the event that two different integration times are assigned to the channels of
a module (10 Hz and 50 Hz), the worst case is calculated. This means that the
calculation is performed with 10 Hz.

Tolerance window
Depending on the quality of the field signal, a tolerance range of 5% to 20% should
be set.

General time or cycle assessment
The redundant modules may only be accessed via the process image.
For more information on how to configure the I/O modules, please refer to
chapter 3.5 "Signal module settings".
The same process image partition must be assigned to both modules of
a redundant pair.
The relevant channel blocks should either have the same cycle time as the process
image process image partition or have their cycle slowed down. No advantage
is gained from being faster than the process image partition.
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3.7 Configuring the HART field devices

Requirements
 The PCS 7 project with an H CPU has been created and is open in SIMATIC

Manager.

 A redundant PROFIBUS-DP master system is configured for the SIMATIC
H station in HW ConFigure

 In HW Config, the interface module IM 153-2 is configured for the ET 200M
at the redundant PROFIBUS DP.

 All required signal modules are configured.

 The redundant ET 200M has been configured.

 The settings on the signal module have been done

Procedure
Table 3–9

Activity Screenshot

1. Open HW ConFigure
Select the HART field device in the
hardware catalog and drag-and-drop it into
a free slot of the HART module in the
module overview.

2. Double-click the HART field device. In the
appearing dialog box, select the appropriate
device and click "OK".
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Activity Screenshot

3. The HART field device is opened in
SIMATIC PDM. Here you can adjust other
device parameters (such as TAG).

4. Select again the HART field device in the
hardware catalog and drag-and-drop it into
a free slot of the redundant partner (HART
signal module of the second ET 200M).
After a brief loading, the configured field
device of the first ET 200M is automatically
assigned.

3.8 Symbolic name assignment

For the symbolic name assignment it is assumed that the input/output modules
have been already added in the HW ConFigure Once this is done, you can assign
self-explanatory symbolic names to the inputs and outputs of these modules.
You use these names to connect CFC charts with the input and output modules.

Requirements
 The PCS 7 project with an H CPU has been created and is open in SIMATIC

Manager.
 A redundant PROFIBUS-DP master system is configured for the SIMATIC

H station in HW ConFigure
 In HW Config, the interface module IM 153-2 is configured for the ET 200M

at the redundant PROFIBUS DP.
 All required signal modules are configured.
 The redundant ET 200M has been configured.
 The settings on the signal module have been done
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Procedure
Table 3–10

Activity Screenshot

1. Open HW KonFigure
Select one of the two interface modules
IM 153-2 in the working range.
The module overview shows you all
input/output modules that you have already
added in the HW ConFigure.

2. In the module overview, select the first
signal module, e.g. "AI8x16Bit".

3. Select the "Edit > Symbols" menu
command. The dialog box "Edit Symbols..."
opens. All absolute addresses of the inputs
of these modules are specified in the list.

4. Position the cursor in the "Symbol" column
next to the address, e.g. "EW 512".
Enter, for example "Temperatur211" and
press the "TAB" key. The entered value
is set and the system automatically fills in
the "WORD" data type.

5. Switch to the "Comment" column.
Here, you can enter an appropriate
comment, or else just press the "TAB"
key again to move the cursor to the next
line, i.e. the "Symbol" column.
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Activity Screenshot

6. If necessary, edit additional symbols
and save your entries by clicking the
"OK" button.
The dialog box "Edit Symbols" is closed.

7. Select each signal module, one after the
other, in the module overview and assign
them symbolic names. To do this, follow the
steps 2 to 6.

3.9 CFC configuration

Once you have completed the necessary configurations, you have to create
CFC charts. In this step you connect the input/output modules you added in the
HW Config with the corresponding channel blocks.

Requirements
 All the required I/O modules have been configured in the HW Config and

the associated symbols have been assigned.
 The CFC chart has been created and is open.

Procedure
Table 3–11

Activity Screenshot

1. Select the "Libraries" tab In the lower left
pane. Select the path "PCS 7 AP Library
V81 > Blocks+Templates\Blocks >
Channel".
Now drag the driver module Pcs7AnIn,
Pcs7AnOu, Pcs7DiIn or Pcs7DiOu and
drop it into your plan, depending on the
input/output module.

2. To connect further building blocks, drag
them into your plan. For example, if you
want to measure temperature, you can
connect the channel block with a MonAnS
or MonAnL, which allow the measured
temperature to be displayed later on during
operation.

3. To connect the channel module with its
configured I/O module, select the block,
click on "PV_In" of the channel block and
open the menu command "Insert >
Connection to Address".
The symbol table opens.
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Activity Screenshot

4. Click on the relative symbol with which you
want to connect the block.
You can select between the symbols that
you assigned in the HW Config during the
symbol assignment (see chapter 3.8).

5. In the final compilation, the module drivers
are automatically generated for the
corresponding blocks. It is important to
make sure that the field "Generate module
drivers" is selected in the dialog window
"Compile program".

6. As a result, the terminals MS, MODE,
DataXchg, DataXchg1 and MS_Xchg of the
channel block are connected automatically
to the @-plans, generated by the system.
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4 Function mechanisms
4.1 Example of a flowchart

The following figure shows an example of a flowchart for redundant I/O modules
and the signal processing in the AS.

Note The example shows the use of two sensors. In the process industry, the
connection of a sensor to a redundant module pair is also typical
(see chapter 2.3).

Figure 4–1

Teilprozessabbild
Aktualisierung
der Eingänge

AI : EW512

AI : EW560

AS:  Zyklus  z.B OB35

CH_AO

Redundante
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...

...
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AO : AW544

CH_AI
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RED_IN

RED_STATUS
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RED_OUT
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AW544
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@-Charts

Symboltabelle
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T
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Description of the upper part of the flowchart
In the upper part, two temperature measurements are transferred by two encoders
via two redundant AI modules and written via two addresses (EW512, EW560) in
the process image partition of the inputs.
Depending on the setting of the transfer value (see Additional Parameters
Table 3–5 point 7), the smaller or greater value is written in the user program on
the channel block CH_AI via the corresponding "TI111" symbol.
The @-charts, where the blocks from the redundant IO CGP (RED_IN,
RED_STATUS, etc.) and from the PCS 7 Library (OR_M16_C) are placed, allow
the diagnostic and redundancy analysis to be performed. The block OR_M16_C
transmits the corresponding diagnostic or redundancy status to the channel block
CH_AI.
This automatically leads to the corresponding redundancy message behavior,
depending on the status (OR_M16_C, see below).

Description of the lower part of the flowchart
In the lower part of the flowchart, a control valve is controlled by two redundant
analog output modules.

Note Only analog output modules with current outputs can be operated redundantly
(0…20mA, 4…20mA). See chapter 2.3.4 "Analog output".

A value is written into the process image partition of the outputs from the channel
block CH_AO via the pre-configured symbol "QCTRL1". The @-charts and
especially the RED_OUT allow information to be analyzed and corresponding
output values to be given out by the system. This is done via the process image
partition of the outputs (addresses AW512 and AW544).
The value to be transferred is halved and each of the two channels transmits half
the value. If one of the channels or modules fails, this is detected and the
remaining channel or module transmits the full value.
This flowchart is repeated cyclically according to call and cycle time of the OBs
used (in this case OB35 every 100 ms).
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4.2 Library functions

The following section describes the blocks/functions used from the PCS 7 and the
Redundant IO CGP libraries.

4.2.1 PCS 7 Basic Library V8.1

OR_M_16C
The block OR_M_16C serves to form a channel-granular value status from two
redundant signal modules.

MOD-D1
The module MOD_1 monitors a max of
16-channel S7-300/400 SM modules which have no diagnostics capabilities
(no mixed modules).
In H systems, only modules in switched racks are supported.

4.2.2 Redundant IO CGP V5.2

RED_IN
The FB 450 ensures reading of the signal from the redundant input peripherals
(DI, AI), which is assigned to the process image partition in the priority class of the
calling OB.
The FB 450 performs a discrepancy analysis of the redundant input peripherals
and saves the valid value to the lower address in the process image inputs (PII).
The user can only access his application this way. The PII of the high module is
irrelevant.

RED_STATUS
The FB 453 "RED_STATUS" represents an interface block and contains
information regarding the passivation of modules.

RED_OUT
The FB 451 transmits those redundant peripheral signals that are assigned to
the process image partition in the priority class of the calling OB.

RED_DIAG
The FB 452 RED_DIAG evaluates the start information of individual fault and
diagnostic OBs to refer to a corresponding processing sequence.
It is called up in the acyclic OBs (e.g. OB 82, OB 85).

RED_DEPA
This function starts a depassivation by the user program.
The FC checks whether a redundant module or channel is passivated. If a module
or channel is passivated, a complete depassivation is started in the FB 450
"RED_IN". In the opposite case (no passivation of a module or a channel present),
the processing of the FC 451 is terminated immediately.
The function is called up in the acyclic OBs (e.g. OB 82, OB 85).
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RED_INIT
With the FC 450 "RED_INIT", the peripheral redundancy is initialized in the startup
of an H system.
When the FC 450 is called up, it generates administration data blocks for functional
peripheral redundancy and it either occupies it with default values or else it
updates pre-existing administration DBs. The function triggers a complete
depassivation, which is then executed in FB 450 "RED_IN".
The function is called up in the acyclic OBs (e.g. OB 82, OB 85).

4.3 OS messages of the modules

When compiling the OS, the following module messages are created in the OS.

Redundancy reporting behavior (OR_M_16C)
 BG x/y/z: Failure of module redundancy pair

 BG x/y/z: Module redundancy loss

 BG x/y/z: Module status cannot be determined

 BG x/y/z: Discrepancy time has expired

 BG x/y/z: Failure of redundancy pair channel xx

Table 4-1

Letter Description

X DP master system no.
Y DP slave address
Z Slot no.
XX Channel no.
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Reporting behavior of a module with diagnostic capability (MOD_D1)
 Possible module fault (output parameter QMODF = TRUE):

– External auxiliary voltage missing
– Front connector missing
– Module parameters not set
– incorrect parameters in module
– Missing/wrong module
– CPU communication fault
– Time monitoring activated (watchdog)
– Module internal supply voltage failure
– Rack failure
– Processor failure
– EPROM error
– RAM error
– ADC/DAC error
– Fuse blown
– Power supply 1: Fault
– Power supply 2: Fault

 Possible channel fault ("invalid value" value status, OMODE_xx = 16#00xxxx):
– Configuration/parameter assignment error
– Common mode error, only analog input/output
– I/O short circuit
– Short-circuit to M
– Output transistor is interrupted
– Wire break
– Reference channel fault (only analog input)
– Below measuring range (only analog input)
– Above measuring range (only analog input)
– Missing load voltage (only analog and digital output)
– Missing encoder power supply (only digital output)
– Fuse blown (only digital output)
– Grounding fault (only digital input/output)
– Temperature rise (only digital output)
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5 Diagnostics
This chapter presents an example of the diagnostic possibilities with PCS 7 in
terms of redundant peripherals.

5.1 Failure scenario

A channel fault due to a wire break is simulated on a digital input module with the
running system.
Figure 5-1

It should be noted that the components used in the example are channel-granular.
A wire break at a terminal of the digital input module results in the passivation of
the faulty channel (or channel group) only and not the entire module. The occurred
fault can be diagnosed in the following ways:
 OS messages
 Asset management
 HW Config
 CFC test mode

In the practical environment, the fault is first seen by the plant operator on the OS
in the control room. Then, the maintenance engineer will have a look at the
appropriate message list.
At the same time, the Asset Management gives him further information about the
condition of the signal module. Thanks to a button, Asset Management provides
the possibility of opening the HW Config to receive further diagnostics entries in
the module status of the H CPU and the signal module.
At the same time, other status values of the signal module are available in the
CFC test mode.
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5.2 OS messages

In the OS, you receive corresponding error messages via the button "New List".
Figure 5–2
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5.3 Asset management

If Asset Management is implemented in your PCS 7 project, you also get data
about faults in redundant peripherals.

Figure 5–3

Note You can find further information in the Application Example "PCS 7 in Practice -
Plant Asset Management".
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5.4 HW Config Online

Diagnostics buffer
In the online mode of the HW Config, you can see the event information shown
Figure 5-4, under the "Diagnostic Buffer" tab inside the "Module State" of the
H CPU. In addition to fault messages, even information about the behavior of the
modules is listed here.
The wire break is listed here in the "Events" field via the numbers 20 to 23.
By highlighting the corresponding message, further information is displayed in
the "Event details" field.
Figure 5-4
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Diagnostic interrupt
The "Module state" of the signal module (Figure 5-5) is another diagnostic
possibility in HW ConFigure In the "Diagnostic Interrupt" tab you can find the
"Standard module diagnostics" and the "Channel-specific diagnostics".
Figure 5-5

By clicking on the "Show" button you receive further information about the selected
diagnostic line.
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5.5 CFC test mode

The OR_M_16C enables the value status of the redundant signal modules to be
diagnosed (Figure 5–6) in the CFC chart.
Here, the different connections of the module can be registered in test mode.
Figure 5–6

From the outputs QMODF1 and QMODF2, you can see that there is no module
fault. From the inputs ACTIV_L or ACTIV _H, you can see whether one of the two
modules is active or passive.
The wire break at the connection MODE1_00 with status 16#FFFF gives an invalid
value.
The MODE1_00 connection shows the status for channel 0 of the primary digital
input module.
The MODE2_00 connection shows the status for channel 0 of the second
redundant digital input module. The 16#8000FFFF at connection MODE2_00 is
a valid value.
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The following table shows further connection properties of the OR_M_16C:
Table 5–1

Connection Meaning Data Type Default
Setting

Type

MODE1_xx Channel operating mode (xx = 00 – 07 / 00 – 15)
of the primary module

DWORD 0 I

MODE2_xx Channel operating mode (xx = 00 – 07 / 00 – 15)
of the redundant module

DWORD 0 I

OMODE_xx Channel operating mode (xx = 00 – 07 / 00 – 15) DWORD 0 O
QDISCREP 1 = expired discrepancy time BOOL 0 O
QMODF1 1 = error in module 1 BOOL 0 O
QMODF2 1 = error in module 2 BOOL 0 O

Note Further information about the connections of the OR_M_16 and its fault
messages can be found in the manual "SIMATIC Process Control System PCS 7
Basic Library (V8.1)".

Examples of the value status
 Byte 3:

– 16#80: Value status "valid value"
– 16#00: Value status "invalid value" (channel fault)
– 16#40: Value status "invalid value" (higher-level fault)

 Byte 2:
– 16#01: Restart (OB 100) done

– 16#02: Above measuring range (channel fault diagnostics)

– 16#04: Below measuring range (channel fault diagnostics)
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6 Related literature

Table 6-1

Topic Title / Link

\1\ Siemens Industry Online Support http://support.industry.siemens.com

\2\ Download page of this entry https://support.industry.siemens.com/cs/ww/en/
view/28430682

\3\ SIMATIC Process Control System -
PCS 7 High-availability Process
Control Systems (V8.1)

https://support.industry.siemens.com/cs/ww/en/
view/90682535

\4\ SIMATIC PCS 7 process control
system CPU 410-5H Process
Automation

https://support.industry.siemens.com/cs/ww/en/
view/74736822

\5\ SIMATIC Process Control System
PCS 7 Basic Library (V8.1)

https://support.industry.siemens.com/cs/ww/en/
view/90683135
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